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Getting Started
Book Learning Objectives

�� Learn the inner workings of the World Wide Web and how web content is 

published and delivered.

�� Learn the key terms and common language of web developers.

�� Learn to use Adobe Dreamweaver to create web pages and websites.

�� Understand and write HTML using Dreamweaver’s tools to visualize, write, 

edit, and test your web pages.

�� Use modern web standards to lay out web pages and control their appearance 

with Cascading Style Sheets (CSS).

�� Become proficient with the Dreamweaver interface and the tools used to 

insert and format text, hyperlinks, images, tables, and multimedia files.

�� Use Dreamweaver to design web pages that look and work great on 

computers, tablets, and smartphones.

�� Publish and update web pages to the World Wide Web.

�� Apply principles of design that lead to attractive, engaging, and effective user 

experiences.

�� Learn how to work with clients to develop project plans that lead to success-

ful web projects. 

Welcome to Learn Adobe Dreamweaver CC for Web Authoring! We use a combination 

of text and video to help you learn the basics of web programming with Adobe 

Dreamweaver CC along with other skills that you will need to get your first job in 

web design. Adobe Dreamweaver CC is a powerful program for working with the 

HTML, CSS, and JavaScript code that make up the modern web experience. Dream-

weaver is widely used within the web design industry and by many company web 

production teams to manage website resources, taking advantage of its dynamic 

authoring environment to create great user experiences for their customers.

About This Book and Video
Learn Adobe Dreamweaver CC for Web Authoring was created by a team of expert 

instructors, writers, and editors with years of experience in helping beginning learn-

ers get their start with the cool creative tools from Adobe Systems. Our aim is not 
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only to teach you the basics of the art of web page design with Dreamweaver, but to 

give you an introduction to the associated skills (like design principles and project 

management) that you’ll need for your first job.

We’ve built the training around the objectives for the Web Authoring Using Adobe 

Dreamweaver CC (2015) Adobe Certified Associate (ACA) Exam, and if you mas-

ter the topics covered in this book and videos, you’ll be in good shape to take the 

exam. But even if certification isn’t your goal, you’ll still find that this training will 

give you an excellent foundation for your future work in web design. To that end, 

we’ve structured the material in the order that makes most sense for beginning 

learners (as determined by experienced classroom teachers), rather than following 

the more arbitrary grouping of topics in the ACA Objectives.

To aid you in your quest, we’ve created a unique learning system that uses video 

and text in partnership. You’ll experience this partnership in action in the Web 

Edition, which lives on your Account page at peachpit.com. The Web Edition con-

tains 10 hours of video—the heart of the training—embedded in an online ebook 

that supports the video training and provides background material. The ebook 

material is also available separately for offline reading as a printed book or as an 

ebook in a variety of formats. The Web Edition also includes hundreds of interac-

tive review questions you can use to evaluate your progress. Purchase of the book in 

any format entitles you to free access to the Web Edition (instructions for accessing 

it follow later in this section).

Most chapters provide step-by-step instructions for creating a specific project or 

learning a specific technique. Many chapters include several optional tasks that 

let you further explore the features you’ve already learned. Two valuable chap-

ters acquaint you with other skills and concepts that you’ll come to depend on as 

you use the software in your everyday work. Here is where you’ll find coverage of 

Domains 1 and 2 of the ACA Objectives, which don’t specifically relate to features 

of Dreamweaver but are important components of the complete skill set that the 

ACA exam seeks to evaluate. Because these chapters aren’t part of the path to learn-

ing Dreamweaver itself, they aren’t included in the printed book. They’re included 

in the ebook editions and in the online Web Edition (to access the free Web  

Edition, see pages xiv–xv). 

Each chapter opens with two lists of objectives. One list lays out the learning objec-

tives: the specific tasks you’ll learn in the chapter. The second list shows the ACA 

exam objectives that are covered in the chapter. A table at the end of the book 

guides you to coverage of all the exam objectives in the book or video.
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Conventions Used in this Book
This book uses several elements styled in ways to help you as you work through the 

projects.

Links to videos that cover the topics in depth appear in the margins.

Text that you should enter appears in bold, such as:

In the Link field in the Property inspector, type http://www.capesnbabes.com.

Terms that are defined in the glossary appear in bold and in color, such as:

The web font that’s used in the header of the page is just what the client is 

looking for. That’s a great thing.

The ACA objectives covered in the chapters are called out in the margins beside the 

sections that address them.

Notes give additional information about a topic. The information they contain is 

not essential to accomplishing a task but provides a more in-depth understanding 

of the topic:

NOTE   The default behavior for background images is to tile across and 
down the container where they are set.

Working in Dreamweaver means you’ll be working with code. We have used sev-

eral conventions to make working with the code in this book easier to follow and 

understand.

In many instructions, you will be required to enter HTML code, CSS rules, and 

properties and other code-based markup. To distinguish the markup from the 

instructional text, the entries will be styled with a code font, like this:

Examine the code <h1>Heading goes here</h1>.

In instances where you must enter the markup yourself, the entry will be formatted 

in bold, like this:

Type the following code: <h1>Heading goes here</h1>.

Within the body of descriptions and exercise instructions, elements may be ref-

erenced by name or by class or ID attribute. When an element is identified by its 

tag name, it will appear as <h1> or h1. When referenced by its class attribute, the 

name will appear with a leading period (.) in code font, like this: .content or 

.sidebar1. References to elements by their ID attribute will appear with a leading 

hash (#) and in a code font, like this: #top. This practice matches the way these ele-

ments appear in the Tag selector interface in Dreamweaver.

	Video 9.5  About 
Copyright

  ACA Objective 2.1
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OPERATING SYSTEM DIFFERENCES

In most cases, Dreamweaver CC works the same in both Windows and Mac OS X. 

Minor differences exist between the two versions, mostly due to platform-specific 

issues. Most of these are simply differences in keyboard shortcuts, how dialogs are 

displayed, and how buttons are named. In most cases, screenshots were made in 

the Windows version of Dreamweaver and may appear somewhat differently from 

your own screen.

Where specific commands differ, they are noted within the text. Windows  

commands are listed first, followed by the Mac OS equivalent, such as Ctrl+C/

Command+C. In general, the Windows Ctrl key is equivalent to the Command (or 

Cmd) key in Mac OS, and the Windows Alt key is equivalent to the Option (or Opt) 

key in Mac OS.

As chapters advance, instructions may be truncated or shortened to save space, with 

the assumption that you picked up the essential concepts earlier in the chapter. 

For example, at the beginning of a chapter you may be instructed to “press Ctrl+C/

Cmd+C.” Later, you may be told to “copy” text or a code element. These should be 

considered identical instructions.

If you find you have difficulties in any particular task, review earlier steps or exer-

cises in that chapter. In some cases when an exercise is based on concepts covered 

earlier, you will be referred back to the specific chapter.

Installing the Software
Before you begin using Learn Adobe Dreamweaver CC for Web Authoring, make sure 

that your system is set up correctly and that you’ve installed the proper software 

and hardware. This material is based on the original 2015 release of Adobe Dream-

weaver CC (version 16.0) and is designed to cover the objectives of the Adobe 

Certified Associate Exam for that version of the software.

The Adobe Dreamweaver CC software is not included with this book; it is avail-

able only with an Adobe Creative Cloud membership, which you must purchase 

or which must be supplied by your school or another organization. In addition 

to Adobe Dreamweaver CC, some lessons in this book have steps that can be per-

formed with Adobe Photoshop and other Adobe applications. You must install 

these applications from Adobe Creative Cloud onto your computer. Follow the 

instructions provided at helpx.adobe.com/creative-cloud/help/download-install-app.html.
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ADOBE CREATIVE CLOUD DESKTOP APP

In addition to Adobe Dreamweaver CC, some extension activities suggested in 

the text require the Adobe Creative Cloud desktop application, which provides a 

central location for managing dozens of apps and services that are included in a 

Creative Cloud membership. Although the central lessons in this book and the 

videos do not require a Creative Cloud subscription, you should explore the ways 

the Creative Cloud desktop application can be used to sync and share files, manage 

fonts, access libraries of stock photography and design assets, and showcase and 

discover creative work in the design community.

The Creative Cloud desktop application is installed automatically when you down-

load your first Creative Cloud product. If you have Adobe Application Manager 

installed, it auto-updates to the Creative Cloud desktop application.

If the Creative Cloud desktop application is not installed on your computer, you 

can download it from the Download Creative Cloud page on the Adobe website 

(creative.adobe.com/products/creative-cloud) or from the Adobe Creative Cloud desktop 

apps page (adobe.com/creativecloud/catalog/desktop.html). If you are using software 

on classroom machines, be sure to check with your instructor before making any 

changes to the installed software or system configuration.

CHECKING FOR UPDATES

Adobe periodically provides updates to software. You can easily obtain these 

updates through Creative Cloud. If these updates include new features that affect 

the content of this training or the objectives of the ACA exam in any way, we will 

post updated material to peachpit.com.

Accessing the Free Web 
Edition and Lesson Files
Your purchase of this book in any format includes access to the corresponding Web 

Edition hosted on peachpit.com. The Web Edition contains the complete text of the 

book augmented with hours of video and interactive quizzes.

To work through the projects in this product, you will first need to download the 

lesson files from peachpit.com. You can download the files for individual lessons or 

download them all in a single file.
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If you purchased an ebook from peachpit.com or adobepress.com, the Web Edition 

and files will automatically appear on your Account page. The Web Edition will be 

on the Digital Purchases tab, and the files will be on the Registered Products tab (see 

step 5 below).

If you purchased an ebook from a different vendor or you bought a print book, you 

must register your purchase on peachpit.com:

1	 Go to www.peachpit.com/register.

2	 Sign in or create a new account.

3	 Enter the ISBN: 9780134396422.

4	 Answer the questions as proof of purchase.

5	 The Web Edition will appear under the Digital Purchases tab on your Account 

page. Click the Launch link to access the product.

The lesson files can be accessed through the Registered Products tab on your 

Account page. 

6	 Click the Access Bonus Content link below the title of your product to pro-

ceed to the download page. Click the lesson file links to download them to 

your computer.

Additional Resources
Learn Adobe Dreamweaver CC for Web Authoring is not meant to replace the docu-

mentation that comes with the program or to be a comprehensive reference for 

every feature. For comprehensive information about program features and tutorials, 

refer to these resources:

Adobe Dreamweaver Learn & Support: helpx.adobe.com/dreamweaver is where you 

can find and browse Help and Support content on Adobe.com. Adobe Dreamweaver 

Help and Adobe Dreamweaver Support Center are accessible from the Help menu 

in Dreamweaver. Help is also available as a printable PDF document. Download the 

document at helpx.adobe.com/pdf/dreamweaver_reference.pdf.

Adobe Forums: forums.adobe.com/community/dreamweaver lets you tap into peer-to-

peer discussions, questions, and answers on Adobe products.

Adobe Dreamweaver CC product home page: adobe.com/products/dreamweaver  

provides information about new features and intuitive ways to create responsive 

web page layouts that display beautifully on any screen.
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Adobe Add-ons: creative.adobe.com/addons is a central resource for finding tools, 

services, extensions, code samples, and more to supplement and extend your 

Adobe products.

Resources for educators: adobe.com/education and edex.adobe.com offer a trea-

sure trove of information for instructors who teach classes on Adobe software at 

all levels.

Adobe Certification
The Adobe training and certification programs are designed to help designers and 

other creative professionals improve and promote their product-proficiency skills. 

Adobe Certified Associate (ACA) is an industry-recognized credential that demon-

strates proficiency in Adobe digital skills. Whether you’re just starting out in your 

career, looking to switch jobs, or interested in preparing for success in the job mar-

ket, the Adobe Certified Associate program is for you! For more information, visit 

edex.adobe.com/aca.

Resetting the Preferences to 
Their Default Settings
Dreamweaver lets you determine how the program looks and behaves (like tool 

settings and the default unit of measurement) using the extensive options in Edit > 

Preferences (Windows) or Dreamweaver CC > Preferences (Mac OS). To ensure 

that the preferences and default settings of your Adobe Dreamweaver CC pro-

gram match those used in this book, you can reset your preference settings to their 

defaults. If you are using software installed on computers in a classroom, don’t 

make any changes to the system configuration without first checking with your 

instructor.

To reset your preferences to their default settings, follow these steps:

1	 Quit Adobe Dreamweaver.

2	 Hold down the key combination Windows key+Alt+Shift (Windows) or 

Command+Option+Shift (Mac OS), and launch Dreamweaver.

3	 Continue to hold down the keys until the Reset Preferences dialog appears.

4	 In the Reset Preferences dialog, click Yes.

The file containing your preferences will be deleted.
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CHAPTER OBJECTIVES

Chapter Learning Objectives
�� Understand how the client-to-design process 

works for creating page prototypes that 
meet the customer’s requirements.

�� Create CSS styling rules that make use of 
background images.

�� Use round-trip editing to insert a source 
Photoshop or Fireworks image file and edit 
the file from within Adobe Dreamweaver.

�� Insert images on a web page and position 
them using CSS floats.

�� Learn the location and purpose of 
Dreamweaver’s image editing tools and the 
recommended methods for their use.

�� Use Dreamweaver’s visualization tools to 
troubleshoot designs and align elements on 
the page.

Chapter ACA Objectives
DOMAIN 1.0   
SETTING PROJECT REQUIREMENTS

1.2	 Summarize how designers make decisions 
about the type of content to include 
in a web authoring project, including 
considerations such as copyright, project 
fit, permissions, and licensing.

DOMAIN 2.0   
UNDERSTANDING WEB AUTHORING

2.4	 Demonstrate knowledge of Cascading 
Style Sheets (CSS) and the behavior of 
basic CSS tags.

2.6	 Demonstrate knowledge of digital images, 
text, interactive elements, animation, and 
video and audio content as they pertain to 
web authoring.

DOMAIN 4.0   
WEB AUTHORING USING ADOBE 
DREAMWEAVER CC

4.1	 Define a new Dreamweaver site.

4.2	 Create a web page and define the page 
layout using HTML, CSS, and div tags.



CHAPTER 4

Getting the Big Picture
Human beings are incredibly visual creatures. Our brains can process 

more information when we view a picture or illustration than we can 

by reading a long passage of text. The old saying “A picture is worth a 

thousand words” is certainly true.

Images and visuals are a huge part of the modern web experience, and 

in a world where you can snap a photo on your phone and instantly pub-

lish it online, visitors to a web page expect to see lots of images. And just 

like graphics, images can be used to define the layout of web pages and 

assist in the usability of the site—making it easier for visitors to find their 

way around and get to the information they’re after.

In this chapter, you’ll take a look at the ways you can use images to 

further define the look and feel of a design, how to insert and position 

images, and the tools that Dreamweaver provides to help you get those 

jobs done.
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Bring On the Art!
Great news! Your client Chris the Cartoonist (Figure 4.1) has provided a ton of 

artwork for the WULVS.com website, and he’s also given you excellent guidance on 

how he wants the design to proceed.

Chris Sez:

I really like the layout of the page! Those colors are kind of weird, but I know that’s 

just temporary, right? Let me tell you a little more about the storyline and the char-

acters in my made-up world.

WULVS is a comic strip built around a security service run by Ray the Werewolf.

In Ray’s world, he works with a group of vampires, zombies, witches, mummies, 

aliens, and other characters who work as guards for hire by the “regular” humans  

of the world.

Part of the fun of the comic strip is how Ray runs his business—and his website—

just like a regular business. After all, a monster has to make a living too. What I 

want to do is use the artwork of the characters in the strip to create Ray’s company 

website, wulvs.com.

I’m going to break down what I want for each page and put it into a separate docu-

ment. OK? I’m looking forward to seeing your work!

Lucky for you, he’s happy with the layout that was made from the wireframes in 

the last chapter, and now you can take the big step of designing the pages the way 

Chris wants. Well, he isn’t sure exactly what he wants quite yet, but that just means 

that you can put on your designer hat and start working on a prototype for this 

site.

To get started on all the new elements for this design, you’ll need to download the 

files that have been provided and define your Chapter 4 website.

Get Your Files Here
As you did in previous chapters, copy the folder that contains this chapter’s files to 

your computer.

1	 Download the project files for this lesson, named chapter-04.zip, from the 

Lesson & Update Files tab on your Account page at www.peachpit.com, and 

store them on your computer in a convenient location.

2	 Unzip the files and copy the chapter-04 folder to the Learn-Dreamweaver 

folder you created in Chapter 1.

Figure 4.1  Chris the 
Cartoonist
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Define the Chapter 4 Website
With the files you’ve been provided for this chapter in the project folder, you’re 

ready to set up the site in Dreamweaver.

NOTE   Refer to Video 1.5, “Defining a Dreamweaver Website,” if you want 
a quick demo of how the site definition process works.

1	 From the application bar, select Site > New Site.

2	 Name the site Chapter 4.

3	 Browse to the chapter-04 folder in your Learn-Dreamweaver project 

folder.

4	 Click Save.

Image File Formats for the Web
Deciding on the right kind of image to include in a web page goes beyond simply 

getting the best picture available and sticking it on a page—although making that 

choice can be a huge chore in itself. You also need to understand which types of 

files will be displayed properly by the viewer’s browser and the type that is most 

appropriate for the kind of image you are adding.

At the most basic level, it’s pretty simple. Web browsers can display three file types:

�� GIF (Graphics Interchange Format) images have filenames that end with the 

.gif file extension. GIFs can display a limited number of colors, which makes 

them very efficient. GIFs are a great choice for graphics—such as logos, illus-

trations, navigation bars, and other design elements—that don’t require colors 

with subtle shades. GIFs can have a transparent background, and of course 

you can animate GIFs to create miniature little movies. How else would we be 

able to see cats playing pianos?

�� JPEG (Joint Photographic Experts Group) files use the .jpg or .jpeg exten-

sion, and as you can probably guess, this format is best used for photographs 

and other images with thousands or millions of colors. JPEG images can be 

compressed by changing quality settings in an image editor to get smaller file 

sizes. Web designers often compare different quality settings in Photoshop, 

  ACA Objective 4.1

  ACA Objective 2.6
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for instance, until they achieve a good balance between how good the image 

looks and its file size. JPEGs cannot have transparent areas and cannot be 

animated.

�� PNG (Portable Network Graphics) is the newest image format. This file type 

was specifically developed for use on the web. The cartoon character images 

you’ve been provided all use the PNG format because images in this format 

can display transparency, sharp edges, and color changes—like a GIF—but 

still allow for subtle shades of colors like a JPEG. PNG files are by far the most 

common file type used by modern web designers.

All these file types are in the family of images known as bitmaps. In a bitmap, 

every color in the image is defined as a tiny block of data with a color value and 

other properties. If you’ve ever zoomed way in on a digital image, you’ve seen those 

individual blocks magnified and seen how the image is composed.

Every image in a web page must be downloaded from a remote server somewhere, 

which makes image file weight—the size of the file as measured by how much 

data it holds—almost as important as how it looks. Large image files are one of the 

primary culprits when a page loads slowly—for example, inserting an image that 

weighs 500 KB versus one that weighs 100 KB.

This process of choosing the right file type and adjusting image properties to get 

the smallest file size possible is known as optimization. Adobe makes two fine 

software programs for editing and optimizing images: Photoshop and Fireworks. In 

fact, the best method for working with images is to compose and edit the images 

in a graphics editor, then export a version that has been optimized for viewing on 

the web.

Whether or not you’re optimizing your images or you’re working with a graphic 

designer who will prepare the images while you take on the coding duties, you do 

need to know the kind of images that are appropriate for different applications. 

Smart designers always work with a source Photoshop or Fireworks file and never 

work directly on an image file or photograph without having a backup.
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PROJECT 4.1

Prototyping and Designing 
with Background Images
Chris has been hard at work and has provided all sorts of new information to work 

with. In the project files for Chapter 4, Chris has supplied a bunch of images and 

specific feedback on how things should look going forward. Based on the instruc-

tions and the materials he has provided, you can start getting content into place.

Examining Client Feedback and Requirements
Take a few moments to familiarize yourself with the new files and folders that 

Chris provided.

1	 Open Dreamweaver and review the structure of the site and the new folders 

and images.

The folders and files you created in Chapter 3 are still in place, but new 

images and documents have been supplied by the client (Figure 4.2). The 

images folder contains lots of new cartoon characters, and the source 

folder contains Photoshop and Fireworks files. Also included are two client 

feedback files.

	

Chapter 4 selected

� Photoshop and 
Fireworks files in 

source folder

Prototype  
web page

Client feedback 
document

  ACA Objective 1.2

  ACA Objective 2.4

  ACA Objective 4.2

	Video 4.1   
Prototyping and 
Designing with 
Background Images

Figure 4.2  The files and 
folders for the Chapter 4 
website
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2	 Open client-feedback.docx by double-clicking the file in Dreamweaver.

The file opens in Microsoft Word. If you don’t have Word installed on your 

computer, you can open the client-feedback.rtf file in almost any 

word processor.

3	 Read through the client feedback from the client.

Deciphering information from a client frequently involves a lot of detective 

work. What specific guidance does the client provide? What things are being 

left up to you as the designer? And most importantly at this stage, can you 

determine enough information to get a feel for how things should look?

4	 Open the client’s design comp by double-clicking wulvs-comp.png.

This file opens in the default graphics editor on your computer (Figure 4.3).

A

C

D

B

The design comp includes the major design elements that the client is 

requesting. The page is centered in the viewport and has a header, sidebar, 

footer, and main content area. You’ll also see design clues as to how the client 

wants images to be used. This is another good time to jot down some notes 

on what you discover in this document.

5	 Now open index.html.

This is the same file that you finished at the end of Chapter 3. Compare this 

file to the client’s composition to see the differences.

Figure 4.3  Major design 
elements in the design 
comp provided by the 
client

A � Header with character 
collage

B � Page background with 
textured image

C � Sidebar and 
navigation area

D � Character inserted 
into the page
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6	 Open prototype.html.

This is a file that you might have developed based on your detective work of 

the information your client provided. In the interest of time, the following 

tasks have been done for you:

�� The document includes the content that will appear in several pages of 

the website. You’ll find new Heading 1 tag sections for the Team, Services, 

Rates, and Contact pages.

�� The Team section has character descriptions, the Services and Rates 

sections have tables of information, and the Contact section has a spot  

for a form.

�� The sidebar area has text for two navigation sections and placeholder text 

for where advertising might go.

�� New CSS styling rules have been created to assign background colors and 

borders to the header and footer areas of the page.

7	 Open the CSS Designer panel. Select the Show Set checkbox in the upper-right 

corner of the panel, and examine the properties that have been applied to the 

#header and #footer rules in this document.

Once you’ve thoroughly reviewed all the changes that have been made and com-

pared those changes to the index.html file, you are ready to move on to more 

styling. You can even close index.html. All the work you do from this point for-

ward will be done in prototype.html.

Prototyping in Web Design
Working with a technical prototype is a very common method used by designers 

as they reach this stage in designing a website. By using a single document like the 

one you’ll work on in this chapter, all the individual images, text, tables, and other 

elements can be placed and styled into a single page. The CSS styling rules remain 

in the <head> of the page while this work is going on, making it easier to keep 

track of the rules as you create, troubleshoot, and modify styles. When the styling is 

complete and the client has given final approval to move forward, the CSS file will 

be converted into a separate, external file, and the contents of each section can be 

copied to the pages where they’ll ultimately reside.

This kind of workflow also allows you as the designer to take advantage of Dream-

weaver’s automation features as final designs are converted to templates and library 

items. These templates and library items make it easier to generate new pages and 

update an entire site full of web pages when a revision takes place.
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LEVEL UP: SMART WORKFLOW

One of the best habits you can have as a programmer is to incrementally 
back up your files as you work. Throughout the course of this chapter,  
you’ll be working on a single file: prototype.html. You should save a  
version of the file as you achieve each milestone in the design process.  
To do this, select File > Save As to make a copy of the file as you go along. 
For instance, at the conclusion of this project you might save this file as  
prototype-project-4-1-complete.html. You’ll continue to work  
on prototype.html, but in case some tragic mishap occurs you can open  
a previous version of the file to recover your work.

Using the Faux Column Technique 
to Style the Sidebar
The client’s design calls for a sidebar to extend down the left side of the page. That’s 

a very common arrangement, but it presents a challenge: How does a web designer 

style this area of the page in such a way that it appears correctly no matter how 

long the web page is? Let’s understand the problem, then see a common solution.

1	 With prototype.html open, place Dreamweaver in Design view. From the 

application bar, choose View > Visual Aids > CSS Layout Backgrounds. You 

can enable and disable this view as you examine the page.

Dreamweaver will apply color coding to help you visualize the <div> 

elements of the page (Figure 4.4).

	

Sidebar content 
does not extend 
down the page

Figure 4.4  The Design 
window with CSS Layout 
Backgrounds enabled
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Notice how the main area content is longer than the sidebar content. You 

could insert your cursor into the sidebar and press Enter/Return to add a 

bunch of empty paragraphs until the sidebar is as full as the content area, but 

that’s a very sloppy way to deal with the issue. Instead you will use a time-

tested method of styling with a background image. This method is known as 

the faux column technique.

2	 Double-click the container-bg-gold.png file inside the images folder to 

open it.

The faux column technique is perfect for a fixed-width page like the one 

you’re working on. To create the illusion that the left column is filled up, a 

background image that matches the width of the container is used for the 

background. In this case, the #container <div> is set at 960 pixels wide.

The #sidebar <div> is 180 pixels wide. The area of the image that will pro-

vide the background color or pattern needs to be set to a matching width. 

Figure 4.5 details how this image is laid out.

Notice that the image is only 20 pixels high. A background image like this 

one doesn’t need to be any larger, because it will repeat vertically inside 

its container.

Image matches the width of 
the container div—960 pixels

The “column” area of the 
image set to 180 pixels wide 
to match the sidebar width

3	 Open the CSS Designer panel, and select the #container selector.

4	 In the Background section, locate the background-image property, click  

inside the field next to url, and then click the Browse for File icon to locate  

the image.

5	 Browse to the chapter-04/images folder, and select  

container-bg-gold.png. Click OK/Open to set the image as  

the background.

6	 To control how the image repeats, or tiles, down the container, set the 

background-repeat property to repeat-y. This will restrict the image to repeat-

ing only down the page and not across.

Figure 4.5  An image for 
use as a faux column

NOTE  
You’ll actually have to 
click the folder icon 
beside the url field 
twice in many cases. 
This might be inten-
tional or just one of 
those little quirks that 
software programs 
have sometimes.
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Background 
category

Browse for 
File icon

background-repeat 
settings

#container 
selector active

7	 Compare your settings to Figure 4.6.

If everything looks good, it’s time to preview your work in your favorite web 

browser. 

Using Images in Page Backgrounds
The second client request to address is for an image that displays on either side 

of the content area of the web page. Chris has provided several different images 

for you to try. You might not actually use these in the final design, but it’s a good 

opportunity to see the different background-repeat settings that CSS provides 

and to see how images may be used to style the entire visible window in a web 

browser display.

This process uses the same tools and techniques you just used on the #container 

selector, except this time you’ll work with the body selector.

1	 Open the CSS Designer panel, and select the body selector. This selector was 

created previously to “zero out” the page margins and to set a temporary 

background color.

2	 Click the Background category, and float your mouse over the background 

color setting, as you see in Figure 4.7.

You’ll see two buttons appear to the right: a button that allows you to disable 

a setting temporarily and a trashcan icon for deleting a property.

Figure 4.6  The CSS 
Designer panel set to the 
Background category
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Disable/Enable 
property

Delete property#body  
selector active

Background category

3	 Click the trashcan icon to delete the background color setting.

Web designers frequently use tiny images set to repeat across and down the 

page to create a wallpaper effect.

4	 Click the Browse icon next to the background-image url field.

5	 Browse to the chevron_bg.png file in the images folder. Select the file, and 

click OK/Open.

The background-image setting will appear (Figure 4.8).

6	 Set the background-repeat option to tile across and down.

NOTE   The default behavior for background images is to tile across 
and down the container where they are set. Although it isn’t necessarily 
required, if you want this default behavior it’s good practice to explicitly set 
that value.

	

Figure 4.8  Background 
image settings in the CSS 
Designer panel

Repeat value set  
to tile (repeat)

Browse for 
image

Path to image

Figure 4.7  Background 
color settings in the CSS 
Designer panel
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7	 Click the Preview in Browser button (   ) in the lower-right corner of the 

document window. When prompted, choose to save and view the file in your 

favorite browser.

You’ll see this one small image tile across and down the page.

8	 Click the Browse icon in the background-image settings area, and switch the 

file to diamond-bg.png. Preview your page in a browser again to see tiled 

background images in action.

The design in Figure 4.9 might not make the final cut, but you should have a 

good idea of how this kind of image can be incorporated into a design.

	

Figure 4.9  Background 
images are tiled inside 
their container when set 
to repeat.

Another common background image design technique is to use a wide image 

with gradients or other visual properties set on either side of a blank area of 

the canvas.

9	 From the source folder, open either gradient-bg.psd (a Photoshop file)  

or gradient-bg.fw.png (a Fireworks file) (Figure 4.10).

Note that this image is quite wide—2200 pixels—but only 20 pixels high. 

You’ll also see that the center portion of the canvas has been filled with a 

white rectangle that matches the width of the #container <div>.

10	Return to Dreamweaver, and use the Browse for File icon in the background-

image setting to switch the background image to gradient-bg.png.

11	Set the background-position setting to 50% left to place this image in the 

center of the viewport. You can drag your mouse to apply this setting, or click 

inside the value field and type the value.Figure 4.10  Background 
images are used in some 
designs to create a gradi-
ent border effect.

Gradients on either side  
of the #container area

Rectangle matches 
#container width
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12	Click the repeat-y icon in the background-repeat area, and compare your 

settings to those in Figure 4.11.

When you preview the page in a browser, or switch to Live view, you’ll see 

that the area on either side of the page contents has a gradient background 

that fades to white. This is another way the client’s requirements might be 

met using background images.

Path to image

Background 
position centered

Background repeat 
set to repeat-y

Background border effect

In this project, you’ve learned how you can use background images as a layout 

technique where a column on the page is visually defined using a background 

image, and you also have seen how the entire viewable area around the page con-

tents can be styled by applying a background to the <body> tag.

LEVEL UP: YOUR OWN BACKGROUND IMAGES

Now that you know how to use background image settings, you can modify 
the properties of the CSS styling rule that is applied to the header area with 
the ID #header.

Select the #header rule in the CSS Designer panel, and apply one of the 
background header images the client has provided.

Looks like Chris is still going with sort of a hipster vibe. The files named 
argyle-bg.png and diamond-bg.png are two examples you might use. 
Or you can work a background image into your own design comp and use 
your own file.

Figure 4.11  The effect of 
using a background image 
that repeats vertically 
down the page
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PROJECT 4.2

Inserting and Editing Images
You accomplished a lot in the first project. You’ve gotten some important page ele-

ments all set using background images and CSS styling rules to style the content 

areas of the page. Did you take the Level Up challenge? If you did, your header 

should also have a nice background image applied to it.

Now it’s time to turn your attention to inserting images into the body of the page. 

Luckily for you, Chris has provided all sorts of images for you, and he’s even opti-

mized them and set the file types of the images properly so you can jump right into 

inserting the images. In this project you’ll use the tools that Dreamweaver provides 

for working with images in a website, try the editing options that are available, and 

follow some recommended practices for modifying images.

From your review of the design comp and the instructions the client provided, you 

know you have a lot of images to insert into the page.

LEVEL UP: DREAMWEAVER PREFERENCES

Dreamweaver allows you to set numerous individual preference settings that 
determine how the software works for you. You can determine which brows-
ers you want to have available for previewing web pages, change the colors 
of your Code window, and set the font size used in the Code window, to 
name a few.

You can also set your preference for which image editor will open when you 
are using the image editing tools while working on a document.

1	 Open Dreamweaver preferences by choosing Edit (Dreamweaver CC) > 
Preferences.

2	 Select the File Types/Editors category in the left column. You’ll see the 
three image file types available for use in web pages (GIF, JPEG, PNG), 
and you can select which editor to use.

3	 Choose the editor you wish to use in the right column, and click Close.

Photoshop is by far the most popular editor to use and is the one most likely 
to appear on your computer if you have the Creative Cloud suite installed. 
Many people also like to use Adobe Fireworks CS6, which is still available as 
part of a Creative Cloud license but is no longer under active development 
by Adobe.

  ACA Objective 1.2

  ACA Objective 2.4

  ACA Objective 2.6

  ACA Objective 4.2

	Video 4.2  Inserting 
and Editing Images

112  Learn Adobe Dreamweaver CC for Web Authoring



Insert an Image Using the Assets Panel
The Assets panel is a great tool for situations in which you have many available 

images and want to identify which ones to use.

1	 If the Assets panel is not already open, select Window > Assets. By default, the 

panel appears in the same panel group as the Files and CSS Designer panels.

The Assets panel makes it easy to sort through all the images in your site and 

displays a preview of the images at the top of the panel. You can slide the 

divider up or down between the preview area and the alphabetical list of files 

to see a smaller or larger preview. Figure 4.12 shows the functional areas of 

this panel.

2	 Scroll through the images to locate ray.png, and select it.

3	 Place your cursor in front of Ray’s introduction to the site (My name is Ray…), 

and click the Insert button in the Assets panel to place ray.png  

onto the page.

Images category

Selected image 
(ray.png)

Insert button

Image dimensions 
and file size (weight)

Slide divider to 
change preview 
area size

Preview area

Figure 4.12  The Assets 
panel with the Images 
category selected
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Scale and Size an Image
As soon as the image displays on the page (Figure 4.13), you can tell that you have 

a big problem. This image is way too large. 

When an image is selected, you’ll see a small, square resize handle appear in the 

image’s lower-right corner. You can scale the image by holding down the Shift key 

while dragging this handle. Or you can click the lock icon in the Property inspec-

tor to lock the aspect ratio and keep the image set to the proper width and height 

dimensions as you drag.

1	 Click the image, and drag the image’s resize handle to what you think will be 

the proper dimensions for this image.

As you resize the image, dimensions will change in the Property inspector. 

Make note of those dimensions.

When you resize or scale an image in this manner, you are changing the 

width and height that the browser will use to display the image. The image 

itself is not changed in any way, and most importantly, the file size of the 

image is the same as always. Placing a large image onto the page and then set-

ting a smaller width and height is a waste of bandwidth. A smaller version of 

this image works better in this case.

File size Edit image in 
image editor

Display 
dimensions

Reset to 
original size

Lock aspect  
ratio

Resize handles

Figure 4.13  The Property 
inspector tools for setting 
image dimensions
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2	 Undo your changes to the image so it returns to its original size, or click the 

Reset to Original Size button in the Property inspector.

In the next steps, you’ll use a better method for editing an image that is too 

large for the page.

Duplicate and Edit an Image
Remember that smart designers never (ever!) destroy an original image. You might 

be tempted to open ray.png in Photoshop, change the image dimensions, save 

the file, and plunk the smaller version onto the page. But that kind of destructive 

process changes the file forever. You could never make the image larger again, and 

because you never really know how you might want to use this image in the future, 

it’s always better to keep the original file as it is and work from a duplicate of the 

file. The Adobe toolset makes this an easy process.

Figure 4.14  The Files panel allows you to duplicate files 
and perform other basic file operations.

A � Expanded images folder

B  ray.png selected

C � Duplicate an existing file

A

B

C

1	 Select the ray.png image, and press the 

Delete key to remove it from the page. You 

will not be using this file for this location.

2	 Click the Files panel, and expand the  

images folder.

3	 Select ray.png. Right-click, and choose 

Edit > Duplicate from the context menu 

(Figure 4.14).

Notice the other basic file operations you  

can perform from the Edit menu.

Anytime you duplicate a file in this way, 

Dreamweaver automatically appends the 

name with “– Copy.” In this case,  

Dreamweaver will create a file named  

ray - Copy.png, which you’ll see listed in 

the Files panel.

4	 Click twice—but not too fast—on the file 

named ray – Copy.png. The filename is 

highlighted in blue. Change the name of the 

file to ray-smaller.png.

This is the file you will use in your design, 

leaving the original image of Ray as it is, safe 

and sound.
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5	 Drag the ray-smaller.png file from the Files panel, and drop it onto the 

page in front of the first sentence (“My name is Ray…”).

The image is at its original size, but now you can safely edit this image with-

out harming the original.

6	 With the image still selected in the page, click the Edit button in the 

Property inspector to open Photoshop (or the default image editor you set 

in Preferences).

7	 Resize the image, and save the changes you make in your image editor. In 

Photoshop, you can resize the image by choosing Image > Image Size. Set the 

image width to 90 pixels, and save the file.

8	 Return to Dreamweaver and note the appearance of the image. It’s still too 

big. The Property inspector still shows the original dimensions. To set the 

dimensions to the new, correct dimensions, click the Reset to Original Size 

button in the Property inspector (Figure 4.15).

New file size (weight) 
measurement

Reset image to 
its original size

Notice that the image is displayed at the dimensions you set when working in your 

image editor. Also note the new file size of this image as shown in the Property 

inspector: only 33 Kb. You saved almost 60 Kb of unnecessary data that doesn’t 

have to be downloaded by a site visitor. And you saved bandwidth and made a 

backup of the original client artwork all at the same time. Good job!

Dreamweaver’s Image Editing Tools
Dreamweaver includes tools in the Property inspector for editing images and per-

forming small adjustments directly in Dreamweaver. But be warned! These tools 

make permanent changes to the image once you save the Dreamweaver page you’re 

working on.

Figure 4.15  Resizing an 
image in a graphics editor 
like Photoshop reduces 
the file size of the image 
and saves on bandwidth.
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Figure 4.16 shows the location of these tools in the Property inspector. You can 

try these out for yourself, but be sure to choose Edit > Undo after you make each 

change so the file you are using isn’t permanently altered.

A	 Crop Image displays a crop area. Use the crop area handles to set the size of 

the area to be cropped. Double-click to crop the image.

B	 Resample Image button is used when you have changed the dimensions 

of an image and you want to improve its picture quality at its new size and 

shape.

C	 Brightness and Contrast is used to make small changes to how dark or light 

an image is and how sharply the colors in the image are defined.

D	 Sharpen adjusts the focus of an image by changing the contrast of pixel edges 

in the image.

A B C D

LEVEL UP: SMART FILE MANAGEMENT

You’re probably beginning to get a feel for just how complex a website can 
become and just how many files and folders there are to deal with. And this 
is a very small website.

One file management method that most web designers use is to keep a 
separate folder within their site where they store all their original Photoshop 
or Fireworks source files. This might also be the location where files used 
in other creative tools, such as Adobe Flash, might be stored. These source 
files aren’t used in the actual HTML documents you create until a version 
of the source is published from the editor to a format that web browsers 
can display. But even though these files aren’t part of the final web page 
product, having them stored inside the main (root) folder for each site you 
create makes it easier to find them when it’s time to make edits and export 
for the web.

Figure 4.16  Image edit-
ing tools in Dreamweaver 
as seen in Design view
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Round-Trip Editing with Photoshop
Recall that at the beginning of this project you were told that smart designers 

always work from an original source file from Photoshop or Fireworks and never 

take actions that will destroy an original. However, web designers in particular 

never know where their artwork might come from or in what format. You might, 

for example, have the freedom to work from an original composition that you 

create in Photoshop, using all your own art and photos to compose something 

entirely new. Photoshop has awesome tools that let you compose an entire page 

layout and design in one PSD file and then export the images and CSS values for 

use in a web design project.

Web designers also have to work in a setting like the one you see here, where the 

client has provided artwork and instructions on how they should be used. Once 

you find that you need to modify an image in any way—changing its size, adding 

text, or even making color corrections to a photograph—you should create a source 

file so you can have a backup on hand in a format that lets you go back and make 

additional changes.

Dreamweaver provides a way to do this by allowing you to make round-trip edits 

from a source Photoshop file. Let’s see how that works.

1	 From the Files panel, expand the 

source folder and locate the file 

named ronni-original.psd.

2	 Drag the ronni-original.psd file 

onto the page at the end of the last 

bulleted sentence.

Dreamweaver will display the Image 

Optimization window, where you’ll 

choose the appropriate image format 

for the file. For this file, you’ll con-

tinue to use PNG24 as the format to 

be saved.

3	 Click the drop-down arrow in the 

Preset field, and select the PNG24 

option (Figure 4.17).

Choose the best file format 
from the available options.

Figure 4.17  The Image Optimization window appears when you insert a 
PSD file in a page.
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4	 Click OK to set the format, and Dreamweaver will open an Explorer or 

Finder window so you can save the image into its web-ready format. 

Browse to the images folder inside the Chapter 4 site, and save the file as 

ronni-edited.png.

In the Property inspector, you’ll see that Dreamweaver is now track-

ing the path and filename of the source image used to create this version 

(Figure 4.18). The next time you click the Edit button, the PSD file will be 

opened in Photoshop and not the version that is on the page.

Now look at the image itself. You’ll see a small icon in the upper-left corner 

of the image that indicates this is a version of an image that came from a 

Photoshop source file and is available for round-trip editing.

Open the source PSD 
file in Photoshop.

Round-trip icon

Path and filename 
of source PSD file

5	 Click the Edit button and the PSD file will open in Photoshop.

Let’s look at a quick demonstration of how round-trip editing works.

6	 In Photoshop, choose Image > Image Rotation > Flip Canvas Horizontal.  

The cartoon character will rotate to face right instead of left.

7	 Save the PSD file, and return to Dreamweaver.

Everything looks the same. No worries. To see the change you made in 

Photoshop, you have to tell Dreamweaver to update the image.

Figure 4.18  Source 
Photoshop files are 
tracked by Dreamweaver.
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8	 Click the Update from Original button in the Property inspector 

(Figure 4.19).

The character is now looking to the right, just as she is in the source file.

9	 Save the prototype.html file you’ve been working on. This project is 

complete.

Update from 
original source file.

You’ve just learned a lot about how images are inserted into web pages using 

Dreamweaver’s toolset. You’ve also seen how you can use Dreamweaver’s built-in 

image editing tools for making minor corrections to an image and how Dream-

weaver and Photoshop can be used together in the recommended workflow, where 

the designer makes edits to a source PSD file that can be easily updated in Dream-

weaver. And don’t forget to always back up your originals!

Figure 4.19  The Property 
inspector when working 
with a round-trip image
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PROJECT 4.3

Floating Images into Position
You have inserted the images for the home page into your prototype page, but they 

still don’t look like the design comp. The two images are currently resting on the 

baseline of the paragraph that contains them. But you can nudge them to the loca-

tion you want using the CSS float property.

In this project, you’ll float the two images into place. You’ll also learn some of the 

principles of floating images, learn how to set the clear property so your floats 

behave themselves, and use some Dreamweaver tools that make this kind of work 

go more quickly.

Create and Apply a CSS Class Selector
By default, images that are inserted into a web page rest on the baseline of the 

element where they’ve been placed. When images are inserted into a paragraph, 

the image will set along this invisible line 

along the same line of text that is adjacent 

to them. The CSS float property is used to 

disengage the image from the baseline and 

allow the text to flow around the image.

1	 Open prototype.html in Dream-

weaver, and make sure the two final 

versions of the cartoon characters—

Ray and Ronni—that you inserted in 

the last project are positioned where 

you want them on the page.

2	 Open the CSS Designer panel, and 

click the + at the top of the Selectors 

section, as you see in Figure 4.20. 

Dreamweaver will create a new blank 

Selector field where you can name the 

selector.

  ACA Objective 1.2

  ACA Objective 2.6

	Video 4.3  Floating 
Images into Position

Figure 4.20  Adding a class selector in the CSS Designer panel 
and assigning properties

A � Click the + to add a new selector.

B � The new selector is listed once a name has been entered.

C � Click to apply padding values to all four sides.

D � .float-right property applied

A

B

C

D
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3	 Name the new selector .float-right and press Enter/Return to accept 

the name.

4	 In the Layout Properties category, click the float-right property button.

You have now created and named a new class selector that can be used over 

and over again within the document.

It’s a good idea to apply a bit of padding to an image so that text doesn’t jam 

up against the side of the image, making the text harder to read.

5	 Click the symbol in the middle of the padding properties section 

(Figure 4.20). Set a padding value of 5 px in one location, and Dreamweaver 

will duplicate the setting to the other three sides all at once—slick!

Now you can assign the .float-right property to one of your images.

6	 Select the Ronni character on the page.

7	 From the Class drop-down menu in the Property inspector (Figure 4.21), 

select .float-right.

The image floats to the right of its container, and the text flows around the 

image. You can drag the image into different areas of the page, but the image 

will always float to the right of its container no matter where you drop it.

Image floats right, 
and text flows 
around the image.

CSS Class assigned 
in the Property 
inspector

TIP  
Class selector names 
always begin with a 
dot (.). One way to 
remember this is that 
your classes at school 
are usually divided into 
periods as well—just 
remember that school 
classes have periods 
and so do CSS class 
selectors.

Figure 4.21  Applying a 
float selector to an image
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Duplicate and Apply a CSS Class Selector
You still need a class selector to float an image to the left, but Dreamweaver has a 

nice way to make this process quick and easy. You can duplicate the existing selec-

tor, modify the name, and change the values for the new selector.

1	 Right-click the .float-right selector, and select Duplicate from the context 

menu. Dreamweaver makes a copy of the selector, and your cursor will be 

positioned inside the name of the new rule.

2	 Change the name of the new selector to .float-left and press Enter/Return 

to accept the new name.

3	 In the Properties section of the panel, change the float setting to left.

4	 Use the Classes setting in the Property inspector to apply the .float-left 

class to the Ray the Werewolf image. The image floats to the left side of the 

content container.

Modify CSS Float Properties  
and Apply Clear Values
The design is looking good, but the image of 

Ronni floated to the right is smashed up against 

the right border of the container. And you could 

have an issue with overlapping images when 

you begin floating more images into place. In 

the next steps, you’ll adjust the padding on the 

.float-right class and set the Clear properties 

that will prevent the floated images from overlap-

ping other elements that have been floated.

1	 In the CSS Designer, select the 

.float-right selector.

2	 In the Properties panel, click the center of 

the Padding section to unlock the settings, 

and change the right padding setting to 

15 px, as in Figure 4.22.

The other settings will remain the same as 

you change this one value. Setting the Clear 

values for each float class is just as easy.

B

C

A

Figure 4.22  Modifying the .float-right class selector and 
setting the Clear value

A � Unlock the padding settings to change individual padding 
values.

B � Set padding right to 15 pixels.

C � Set clear value to Both.
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3	 With the .float-right selector still selected, click the Both value for the 

Clear setting (Figure 4.22).

4	 Select the .float-left selector, and repeat the process of setting the Clear 

value to Both.

With both float classes properly set to clear: both, the next image you float 

will position correctly without any overlap.

Add Alternative Text to Images
For web pages to be accessible to individuals with vision and other disabilities, 

web page images must always include alternative text. Many government agencies 

require web pages to meet accessibility standards, and it’s also just a good practice 

to follow because the description will display in the event the image doesn’t display 

for some reason. Assistive devices, such as screen readers, will read the alt text to 

an individual who might not be able to see the image clearly. It’s also helpful when 

your site is indexed by search engines, so it’s never a bad thing to be thorough and 

include alt text. This task is usually handled with the Property inspector.

1	 Select the image of Ray.

2	 In the Alt field in the Property inspector (Figure 4.23), type Ray the 

Werewolf. Click anywhere on the page to accept the value.

	

Figure 4.23  The Alt text field 
in the Property inspector

Type a short description of 
each image into this field.

3	 Select the image of Ronni.

4	 In the Alt field, type Ronni the Vampire, and click outside the field to accept 

the value.

That’s it; pretty simple.

This project introduced you to the concept of floating images—the process where a 

CSS rule is applied to an image so that text can flow around the image. You know 

now how to use Dreamweaver to create a new class selector, how to assign the prop-

erties and values you want to the selector, and even how to duplicate a selector to 

make the design process go a little faster. You’ve also learned about how to assign 

alt text to images so that your work meets accessibility standards. Another nice 

piece of work!
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PROJECT 4.4

Creating Structured 
Layouts with Images
In the last two projects, you worked a bit with client-provided artwork to float 

images onto the page. Where there are single images like the ones you’ve used so 

far, inserting images and applying a float to move the graphic into position is rela-

tively easy.

But the About Our Staff page features blocks of text with the name and description 

of each character in the comic strip. In the olden days, layouts like this—where an 

image is aligned and positioned next to a paragraph of text—would have been done 

using tables. In the modern world of web design, designers use more efficient meth-

ods that take advantage of advances in browser support for CSS.

Dreamweaver accommodates the kinds of efficient, CSS-based designs that have 

become the industry standard but also adds some visualization features that allow 

designers to get things just right.

The Design Challenge
The page that features all the characters from the comic strip should have a photo 

of the character, with their name and “bio” alongside the image. The client help-

fully provided all the character images at the same width and height, which will 

make the design work a bit easier.

The challenge for this layout is to maintain the association between the text and 

the image. You might consider inserting the image and using the CSS floats that 

were created in the last project to slide the image into place. The problem with 

this approach is that floated images don’t create a new “break” within the content 

on the page. You would have to insert a number of empty paragraphs by pressing 

Enter/Return over and over until each image appeared next to a line of text and 

had blank areas between each character. Or you might consider inserting a table 

and placing the images into the left column and the text into the right column. 

Both of those approaches are semantically incorrect, difficult to maintain, and just 

a bad idea.

  ACA Objective 1.2

  ACA Objective 2.6

	Video 4.4  Creating 
Structured Layouts 
with Images
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The better approach is to create a container that holds both the image and the text, 

and then use the power of CSS classes to define the container and all the content 

that applies to each character. The result of this project’s work will have the image 

of each character appear next to its information (Figure 4.24).

Figure 4.24  When this 
project is complete, each 
character will have its own 
content box to display its 
image and bio.

Preparing Content for the First 
Character Container
The client provided the name of each character and their bios in the Team Page 

area of prototype.html. With that file open, it’s time to begin.

1	 Place your cursor after the first character’s name (Ray), and press Enter/Return 

to insert a new paragraph. Clean up any extraneous characters or spaces until 

your text appears as follows:

Ray

Ray is the originator of…

2	 Place your cursor in front of Ray’s name, and use the Property inspector to 

assign the Heading 3 format to the character’s name.

3	 In the Assets panel, locate the ray-named.png file, and insert it into the page 

in front of the character’s name.
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Inserting a <div> for the Character Content
Now you need to create the container that will hold all the contents for each 

character: their image, their name, and their description.

1	 Drag to select the image and all the text associated with Ray (Figure 4.25).

	

2	 Choose Insert > Div in the application bar. The Insert Div dialog appears.

3	 Leave the Insert field in this window set to Wrap Around Selection, and click 

the New CSS Rule button at the bottom of the dialog. The New CSS Rule 
dialog appears.

4	 With the Selector type at the top of the window set to Class, name the new 

rule .characters. Click OK. The CSS Rule Definition dialog appears.

5	 Select the Box category in the Category column, set the Float property to 

left and the Clear property to both (Figure 4.26), and click OK.

You return to the Insert Div dialog.

6	 Click OK in the Insert Div dialog to complete the process of inserting 

the <div>.

A B

Figure 4.25  The content 
on the page selected and 
prepared for styling

Figure 4.26  The CSS Rule 
Definition dialog for the 
new .characters rule

A � Select the Box 
category.

B � Set the float and clear 
properties as shown.
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The image and all the text are now contained inside their own container with the 

attribute of class="characters". Dreamweaver displays this container with a 

dotted line around it when you are in Design view. 

Floating an Image Inside a Container
Now it’s time to style the elements that are contained within this new <div>. 

Take note that these styling rules will use descendent selectors to create styling 

rules that will apply to any content found inside a <div> with the class name of 

.characters applied.

1	 Select the image of Ray.

2	 In the CSS Designer panel, click the + in the Selectors section to create a new 

rule based on the item selected on the page.

Dreamweaver will suggest that you name this rule .characters h3 img. 

Do you see how the cascade works? This rule will apply to any image that is 

inside an <h3> tag that is located in a <div> with the .characters class.

But this is a little more specific than you need in this case.

3	 Delete the h3 descendent so that your rule name is .characters img.

This rule will now apply to any image found within the .characters <div>.

4	 In the Layout category in the Properties section, set the float property to left 

and the clear property to both (Figure 4.27).

The text that’s associated with Ray jumps up beside the image, just like you 

want. Don’t be too concerned about the position of other characters on the 

page. Once all the containers are in place, things will sort themselves out.

A
B

Create a Second Character <div>
To see the interplay between two boxes that contain a character, let’s repeat the 

process you just followed for the Ronni character and insert a <div> around that 

area of the page.

Figure 4.27  Settings for 
the .characters img rule

A � Choose the selector 
name.

B � Apply float and clear 
properties.
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1	 Edit the text so that Ronni’s name is on a new line with her description below 

her name.

2	 Format the character’s name as an <h3>.

3	 Insert the image ronni-named.png to the left of her name.

4	 Select all the text and the image, and then choose Insert > Div from the appli-

cation bar or from the Insert panel.

5	 In the Insert Div dialog, select the existing CSS .characters class from the 

Class drop-down menu (Figure 4.28). Click OK.

The contents of this new <div> snap into place, and you now have two con-

tent boxes that you can use to adjust the styling.

	

Figure 4.28  You can 
assign an existing CSS 
class when you insert a 
new <div>.

Styling the Content Containers
Now that you have two character containers, you can fine-

tune the styling properties for their contents. The beauty of 

using CSS rules is that once you adjust the settings for one 

container, all the other containers with the same class applied 

will be automatically updated.

1	 In the CSS Designer panel, select the .characters 

selector, and apply a border to the box. Make the border 

1 pixel wide, with the style set to solid and the color set 

to black (#000000).

You can select the Show Set checkbox to see only those 

properties assigned to the selector. Your settings should 

match those in Figure 4.29.

When you switch to Live view, you’ll see that the two 

containers have no space between their respective boxes. 

Text within the box is too close to the image, and the 

boxes are jammed up against the right side of the page. 

You’ll adjust these settings using the margin and pad-

ding properties.

A

B

C

Figure 4.29  Border properties added to the 
.characters selector

A  Choose the selector name.

B  Existing float and clear properties

C  New border property settings
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2	 With the .characters rule still selected, turn to the Layout 

category of the CSS Designer panel, and set the bottom mar-

gin of the container to 10 px. This adds space between the 

two boxes and separates them from each other.

3	 Apply a right margin of 15 px. This moves the right edge of 

the container away from the edge of the page.

4	 Apply a right padding of 10 px. This moves the text within 

the box away from the right border of the box.

The final settings for the .characters rule should appear as 

in Figure 4.30.

The final bit of tweaking needs to take place on the image, 

adding a bit of padding to the image to provide some “air” 

between the image and the text.

5	 Select the .characters img rule.

6	 In the Layout category, assign the padding values that you 

think look best for the right, bottom, and left padding prop-

erties. This is a great time to work in Live view so you can 

clearly see the changes that you make as they are applied.Figure 4.30  Final settings for  
the .characters rule

Aligning Elements with Guides
One of the big advantages to using Dreamweaver to create and style web pages is 

the ability to put visualization tools into place that let you fine-tune your design. 

Guides are horizontal and vertical lines that Dreamweaver displays as you’re work-

ing. You can use these guides to check the alignment of elements on the page.

1	 With your document in Design view, choose View > Rulers > Show to display 

rulers on the top and left side of the document window.

2	 Choose View > Guides > Show Guides. With this option selected, you can 

click one of the rulers and drag a guide onto the page.

3	 Click the top ruler, and drag to position a guide directly above the first char-

acter’s name. If you’re having problems getting the guide into just the right 

place, deselect both View > Guides > Snap To Guides and View > Guides > 

Guides Snap To Elements.
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As you can see in Figure 4.31, the image isn’t perfectly aligned with the text. 

But you can fix that easily enough.

	

Figure 4.31  Rulers and 
guides allow you to check 
alignment of page elements.

Drag guides onto the page 
to check alignments.

Rulers appear on the left and 
top of the Document window.

4	 In the CSS Designer panel, select the .characters img rule, and adjust the 

top padding property to push the image down until it perfectly aligns with 

the character’s name.

5	 Drag a guide from the left ruler and position it in line with the right border of 

the character box.

As you scan up the page, you’ll be able to see whether everything falls into 

alignment with this guide. Everything looks good in your character boxes, but 

the text in the paragraphs contained in the #content <div> are not in line 

with the borders of the character containers.

6	 Click anywhere in the first line of the introductory text on the page, then 

click the + in the Selectors section of the CSS Designer panel. Dreamweaver 

will suggest that this rule be named #container #content p.

7	 Press the Up Arrow key on your keyboard to make this rule a little less spe-

cific. The actual name you’re after here is #content p, which is specific 

enough for your purposes.

8	 Apply a right padding setting to this rule until the text in this paragraph and 

in others on the page is aligned with the guide.

9	 Save your page, and preview it in your favorite browser. Look for alignment 

issues that need to be addressed and return to Dreamweaver to make adjust-

ments to the styling rules you’ve just created.
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Completing the Character Page Listing
You’re almost finished with this project; you have just one more task to complete. 

Following the same steps you used to get the Ray and Ronni character contain-

ers constructed, you need to edit the text, apply a Heading 3 to the character’s 

name, and then insert the character’s image next to the name. You’ll then wrap 

the character’s contents into a new <div> and assign the .characters class. As 

you complete each container, the styling rules you’ve created will be applied to the 

contents, and before long all the employees of WULVS will have their own neatly 

aligned listing on the page.
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PROJECT 4.5

Styling the Header Area
From the client feedback document you reviewed, you know that the final design 

needs to feature some of the characters from the comic strip at the top of the page 

in the header area. That’s going to be a relatively easy task to accomplish since you 

can use CSS floats and a couple of collage images that the client has provided.

While you’re styling this area, you should tend to some other matters as well. In 

this project, you’ll insert and float the images into the header area, add links to the 

home page of the site, and use a web font to style the name of the company.

LEVEL UP: YOUR DREAMWEAVER SKILLS

Throughout this book, you’ve seen lots of detailed instructions on how 
to apply settings and where to find the different working areas of Dream
weaver’s user interface. But now it’s time for you to build your confidence 
in using the application by following the steps provided for this project 
without a great deal of extra instruction. You can follow along with the video 
of course, but at this point I’m confident that you’re capable of doing more 
on your own. You’ll be more confident too if you endeavor to do more and 
more on your own as you go forward.

Inserting and Floating the Header Images
Your client has provided new images that he wants to include at the top of the 

page to the left and right of the company name. In the following steps, you’ll insert 

these images into the header area of the page and then place them into position.

The header area will need some additional room for the images to fit within the 

container. So let’s do that first.

1	 In the CSS Designer panel, choose the #header selector, and set the 

height in the Layout category to 136 pixels. You’re now ready to insert the 

collage images.

2	 Place your cursor in front of the first letter in the first line of text in the 

header area.

  ACA Objective 1.2

  ACA Objective 2.6

	Video 4.5  Styling 
the Header Area
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3	 Using the Assets panel, insert the images header-collage-left.png and 

header-collage-right.png. These images will be floated, so you can just 

place them side by side. Name the images in the Alt field of the Property 

inspector.

4	 Select header-collage-left.png, and assign the float-left class to the 

image in the Property inspector. The image snaps into place on the left side of 

the header.

5	 Select header-collage-right.png, and assign the float-right class to 

the image.

This time the image isn’t positioned properly; it falls outside the header. That’s 

not good, but more than likely the issue has to do with the clear: both 

property that is assigned to this rule. Since you don’t want to change the 

existing float-right class that’s in use in other parts of the design, you 

need a new rule for this image.

6	 Right-click the .float-right rule in the Selectors area of the CSS Designer 

panel, and select Duplicate.

7	 Change the name of the rule to .float-right-header.

8	 In the Layout category of the CSS Designer, change the clear value for this 

rule from clear: both to clear: right. This change allows the image to 

properly float into place within the header.

9	 Select header-collage-right.png, and assign the float-right-header 

class to the image. This image snaps into place.

Adding Links in the Header
It’s common—even expected—for a visitor to a website to be able to click the 

header at the top of the page and go to the site’s home page. You’ll add links to 

the two images and to the company name to make this possible. Later, when this 

prototype is converted into a template, the links will be in place and ready to go.

1	 Click the header-collage-left.png image. In the Property inspector Link 

field, enter the filename of the home page: index.html.

2	 Click the header-collage-right.png image. Link this image to the 

index.html home page.

3	 Select the name of the company in the center of the header area on the page. 

Link the text to the index.html home page.
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Removing Default Styles from Text Links
Text links by default have always been shown in blue, underlined text. This obvi-

ously won’t work for the design the client is after, so you’ll remove those properties 

from the <a> tag with a new CSS styling rule.

1	 Place your cursor anywhere within the company name in the header.

2	 Click the + in the Selectors area of the CSS Designer panel. Press the Up  

Arrow key once so that the new selector name is set as #header-name a.  

Press Enter/Return to accept the name.

3	 In the Text category, set the text color to black and text-decoration to none. 

Looking at the CSS you just wrote, you should see the following code block:

#header-name a  {

	 color: #000000;

	 text-decoration: none;

}

Styling the Company Name with Edge Fonts
The client asked for some “weird- or scary-looking” text for 

the company name. To get text that goes beyond the common 

fonts that are standard across browsers, you can use Adobe 

Edge Fonts, which is a free service, to find more interesting 

fonts to work with. The company name in this document 

already has a rule applied to which you can easily add addi-

tional properties and values to make the name “weird or scary.”

1	 Select the header-name rule in the Selectors area of the 

CSS Designer panel.

2	 Set the text color to black (#000000).

3	 Click inside the font-family field. From the menu that 

appears, select Manage Fonts.

Adobe Edge Fonts are free font packages that will be 

loaded into the page with a little snippet of JavaScript 

that is inserted into the <head> of the document. The 

Manage Fonts dialog you see in Figure 4.32 allows you to 

choose one of these fonts to use in your page.

Figure 4.32  Adobe Edge Fonts can be selected 
from this window and loaded into a font library 
on your computer.
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4	 Select the font amatic-sc or try out another font that you like. Click Done 

to load the font into your library.

Once you load a font into your library, you can assign the font as a property. 

5	 Click inside the font-family field, and select the amatic-sc font (or which-

ever font you loaded) for this rule.

6	 Switch to Live view to see the appearance of the text. Edge and Web fonts dis-

play properly only in Live view.

7	 Use the font-size and font-weight settings for this rule to make the text appear 

the way you like. For this example, your styling rule might appear as follows:

#header-name {

	 margin-top: 0px;

	 color: #000000;

	 font-family: amatic-sc;

	 font-weight: 700;

	 font-size: 36px;

}

Styling the Company Tagline
One more job to take care of. You need to style and position the tagline that falls 

below the company name. Here’s the styling rule that was created to get this done 

in the video demonstration:

#header-tagline {

	 margin-bottom: 0px;

	 color: #1B1B1B;

	� font-family: "Gill Sans", "Gill Sans MT", "Myriad Pro",  
"DejaVu Sans Condensed", Helvetica, Arial, sans-serif;

	 font-style: italic;

	 font-size: 14px;

	 margin-top: -36px;

}

Can you figure out where to apply these settings in the CSS Designer panel?

In this project you’ve taken another step in becoming proficient with Dreamweaver 

by diving in on your own to insert images and links and apply styling to the header 

of the page. Another job well done! Do you feel your confidence rising?
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Challenge! Create Your Own 
Design with Photoshop
As you’ve worked through the material in this chapter you’ve no doubt thought of 

lots of ways that this design might be done. The client provided only some general 

guidance, and the examples you’ve seen here took off in sort of a hipster-look direc-

tion. But you’re heartily encouraged to do better by creating your own design.

To help get you started, the project folder for this chapter has two files 

in the source folder that you can use to create your own design comps. 

You’ll find a file for Photoshop (wulvs-layout.psd) and one for Fireworks 

(wulvs-layout.fw.png). Both files are already organized into layers that match 

the dimensions used in developing this prototype. It’s up to you to open those files 

and use your own creative ideas to make a totally new design.

Conclusion
Although the title of this chapter is “Getting the Big Picture,” it might as well have 

been named “Working with Backgrounds, Inserted Images, Named CSS Class Rules, 

and Dreamweaver Visualization Techniques.” Well, that’s a little long, but that’s just 

what you’ve accomplished as you’ve worked through these projects.

Along the way to learning how to use Dreamweaver to include the visual elements 

that images provide, you’ve also learned more about the principles of web design, 

how CSS styling rules are used to position elements on a page, and even how to 

style text using CSS and fonts that are located on a web service.

And the great news is that your design work is nearly complete. In the next chapter, 

you’ll work to get the final elements of this design wrapped up as you learn how to 

style navigation bars, tables, and more.
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A
<a> tag, 11, 27–28
absolute links, 247
absolute positioning, 247
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active hyperlink, 247. See also hyperlinks
additive color, 247. See also colors
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alien planet, first steps on, 5
alignment
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of elements with guides, 130–131

all caps, 247
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animated GIF, 247
animation, 229–236
application bar, 41–42
argyle-bg.png file, 110
art, elements of, 250
<article> tag, 11
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Assets panel
inserting images with, 113

using, 57–59, 145
asymmetrical, 247

attributes
accessing, 30
adding, 11, 27, 83–88
defined, 248

B
Back/Forward buttons, 46
background color. See also colors

choosing from images, 151
setting, 91

background images, using, 108–111. See also images
backing up files, 106

balance, 248
bandwidth, 248
baseline, 248
bitmaps, 102, 248
blackletter fonts, 248
<blockquote> tag, 49
<body> tag, 9, 27, 76
Bold settings, accessing with Property inspector, 49
Bootstrap, 207. See also responsive design

components in Dreamweaver, 217–219
explained, 248
glyphicons, 218–219
media queries, 217
modifying properties, 219–220
overriding settings, 221–222
responsive design page, 216–217

boss, thinking like, 66–68
box model, 45, 90, 248
Brightness and Contrast tool, 117
Browse to File button, 35
browser

capabilities, 14, 26
defined, 4, 248
previewing files in, 110
previewing pages in, 171
starting up page inspectors in, 224

browsing to folders, 22, 40

C
“Capes & Babes” online comic, 64
card container, styling for CSS3 animation, 231
cartooning, 64
cast shadow, 248
chaotic lines, 248
character container, preparing content for, 126
character content, inserting <div> for, 126–129
check in and check out, 248
Check In/Check Out button, 57
child selectors, 158, 176, 248
Chris the Cartoonist project. See also project files

client feedback and requirements, 103–105
described, 64
downloading files, 65
font formats, 77–81
home page, 69
links, 81–82
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page properties, 71–76
problem definition, 66–68
site setup, 65
site structure, 68–70

class attribute, 11, 28
class rules, 49
class selectors, 176, 249

applying, 123
creating and applying, 121–122
duplicating, 123

classes
applying to objects, 219–220
versus IDs, 87

cleaning up code and design169–170
clear values, applying, 123–124
client

defined, 249
versus server, 6

client feedback and requirements, 103–105
client project requirements, translating, 66–70
client resources, 72
client survey (interview), 249
client-side programming, 249
code. See also writing in code

cleaning up, 169–171
examining in web pages, 24–31

code collapse, 60
code coloring, 30
code hints, 59
Code Navigator, 60, 88, 249
coding tools, 59–60
color harmonies, 249
Color selector, 91
coloring code, 30, 59 
colors. See also additive color; background color; 

primary colors; secondary colors; subtractive 
color; tertiary colors

adding to text, 12
defined, 249

column widths, setting, 157–158. See also widths
Command key. See keyboard shortcuts
commenting style sheets, 179–180
company name, styling with Edge Fonts, 135–136
company tagline, styling, 136
comparing documents, 25
complementary colors, 249
computers, function of, 4–5
connections

diagram of, 6
making, 5–7
to servers, 57

#contact-form selector, creating, 165
#container <div>, styling, 92
container selector, choosing, 107
containers

floating images in, 128
styling for CSS3 animation, 229–236

content. See also optional content
adding to web pages, 73–76
converting to Library Items, 190–192
selecting, 86

content containers
adding, 83–88
styling, 129–130

content organization, viewing, 26. See also 
document tree

contrast
adjusting, 117
defined, 249

copying. See also get; put
folders, 39
pages, 32
plain text, 74
project files, 20–21

Create tab, choosing, 21–22
Creative Commons, 249
Crop Image tool, 117
CSS (Cascading Style Sheets), 7

commenting, 179–180
converting to external CSS files, 180–182
defined, 248
float property, 121–122
shorthand notations, 177–178
source order, 178–179
types of, 175
viewing disabled, 25

CSS box model, 45, 90, 248
CSS class rules, 49
CSS class selectors, 176, 249

applying, 123
creating and applying, 121–122
duplicating, 123

CSS Designer panel, 31, 54–55, 90–95
CSS files. See also files

applying override settings, 222–224
customizing for Bootstrap settings, 221–222

CSS float property
modifying, 123–124
using, 121–122

CSS mode, using in Property inspector, 49–52
CSS properties, adding, 75–76
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naming, 22
site definition, 21–22
Workspace Layout, 23

Dreamweaver workspace
customizing, 53
layout, 23, 259

duplicating images, 115–116
dynamic website, 16, 250

E
Edge Fonts, styling company name with, 135–136. 

See also fonts
editable regions, 184–185, 189–190
editing images, 115–116
edits, round-tripping, 51
element selectors, 76, 176, 250
element styles, 28. See also styles
elemental CSS properties, adding, 75–76
elements

of art, 250
positioning with CSS, 90–95

<em> tag, 49
emphasis, 251
encoding, 251
error checker, 48
error indicator, identifying, 170
external style sheets, 175, 251

F
fair use, 251
faux column technique, using with sidebar, 

106–108
feedback loop, 251
file extension, 16, 251
file management, 47
File panel, displaying, 23
File path, displaying in Document window, 46
file weight, 102, 251
filename, locating, 32
files. See also CSS files; folders; local and  

remote files; project files; related files; 
synchronizing files

backing up, 106
managing, 117
organization of, 16–18
refreshing, 57
saving, 32
synchronizing, 57, 199–200
updating on server, 198–199

CSS styling rules, 12–14, 28–30, 207
creating, 179
filtering, 214

CSS3 animation, 229–236
CTRL key. See keyboard shortcuts
curved (line), 249
cutting and pasting text, 73–74

D
database, 15–16, 249
declaration block, 249
decorative fonts, 249
default styles, removing from text links, 135. 

See also styles
deliverables, 249
deprecated, 250
descendant selectors, 176, 250
design, cleaning up, 169
design comp, 83–84, 250
design elements, 250
design principles, 250
Design view, 27, 31, 44, 249
Designer panel, 31, 54–55, 90–95
Device Preview, 47
diagonal (lines), 250
diamond-bg.png file, 110
dingbat fonts, 250
direction, 250
<div> tags, 85–88, 92–95
<!doctype>, 9, 73, 250
Document tabs, 42
Document toolbar, 45, 250
document tree, 250. See also content organization
Document window, 41–48

File path, 46
media queries, 46
Refresh option, 46
related files, 45

documents, comparing, 25
DOM (Document Object Model), 8, 250
DOM panel, locating, 26–27, 88
domain names, 6, 250
domain objects for ACA, 240–246
dragging and dropping links, 81
Dreamweaver, features of, 38
Dreamweaver websites. See also websites

copying project files, 20–21
defining, 20–22
downloading sample files, 19–20
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G
geometric lines and shapes, 252
get, 252. See also copying; put
GIF (Graphics Interchange Format), 101
glyphs and glyphicons, 218–219, 252
graphic design, 70
group selectors, 176, 252
guides, aligning elements with, 130–131

H
<h1> tag, 10, 26
hand-drawn lines, 252
handwritten fonts, 252
head (of document), 252
head in web page, 9
<head> tag, 9, 26
header, adding links in, 134
#header <div>, styling, 93
header images, inserting and floating, 133–134. 

See also images
heading properties, setting, 157–158
heads-up display, 220
hexadecimal, 252
hey.html web page, 9
hidden formation, locating, 26
highlight, 252
home page. See also web pages

creating, 69
replacing, 185–186

horizontal, 252
hover values, setting, 153–154
href value, writing, 82
HTML (Hypertext Markup Language), 7, 26, 252
HTML mode, using in Property inspector, 48–49
HTML Reference Page, 10
HTML standards, release of, 206–207
HTML5. See also tags 

explained, 252
tags and media queries, 212–213

HTML5 video
assets, 225–226
inserting, 226–228

HTTP (Hypertext Transfer Protocol), 5, 253
hyperlinks, 4, 252. See also active hyperlink

adding for other pages, 147–148
adding in header, 134
creating, 81–82
dragging and dropping, 81
styling in footer, 95

hyphenation, 253

Files panel
explained, 251
Mac versus Windows, 70
using, 56–57

Flick, Chris, 64
float property

modifying, 123–124
using, 121–122

flow, 251
fluid design, 207
focal point, 251
folder location

browsing to, 40
identifying, 21

folders. See also files
copying, 39
browsing to, 22
organization of, 16–18

font family, 251
font settings, displaying, 75
font weight, 251
fonts. See also Edge Fonts; sans serif fonts;  

script fonts; serif fonts; web fonts
defined, 251
fixing, 168–169
handwritten, 252
monospaced, 254

footer, styling links in, 95
#footer <div>, styling, 94
Footer area, creating, 85
footer ID, creating, 88
form tag, inserting, 162–163
formatting text, 77–81
forms

adding function to, 164
defined, 251
form tags, 162–163
inserting text from Word, 161–162
list labels, 163
Select form, 163
styling, 165
text fields, 162–163

forward slash (/) character, 8
Forward/Back buttons, 46
frameworks, 207, 251
FTP (File Transfer Protocol), 251
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internal style sheets, 28, 175, 253
Internet

development of, 4
explained, 13
versus World Wide Web, 4

IP (Internet Protocol), 6, 253
IP address, 6, 253
iPhone, release of, 206
Italic settings, accessing with Property inspector, 49
iterations and iterative work, 253

J
JavaScript, 7–8, 207, 253
JPEG (Joint Photographic Experts Group), 101–102
jQuery Mobile, 207, 217–219, 254
justified, 254

K
kerning, 254
keyboard shortcuts

cutting and pasting text, 73–74
opening web pages, 9
selecting content, 86

L
layouts. See structured layouts
leading, 254
Learn-Dreamweaver folder, contents of, 39
<li> tag, 80
library items, 254

adding optional content with, 189–194
converting content to, 190–192
creating from scratch, 192–193
inserting and updating, 194

licensing, 254
ligatures, 254
light source, 254
lines

defined, 254
geometric, 252
hand-drawn, 252
implied, 253
organic, 255
styles, 258
varying width, 259
weight, 259

link values, setting with pseudo-class selectors, 
152–153

links. See hyperlinks; navigation links

I
ID selectors, 176, 253
ideographs (ideograms), 253
IDs versus classes, 87
image container, styling for CSS3 animation, 231
image editing tools, 51–52, 116–117
image file formats

GIF (Graphics Interchange Format), 101
JPEG (Joint Photographic Experts Group), 

101–102
PNG (Portable Network Graphics), 102

image maps, 52, 253
images. See also background images; header images

adding alt text to, 124
choosing background colors from, 151
clarifying paths to, 188
creating structured layouts with, 125–132
duplicating, 115–116
editing, 115–116
floating inside containers, 128
floating into position, 121–124
inserting in sidebar, 144–145
inserting using Assets panel, 113
locating, 35, 145
positioning in sidebar, 145–146
Property inspector for, 50–52
replacing on pages, 34–35
resizing, 116
scaling and sizing, 114–115
using in page backgrounds, 108–111
width and height, 51

<img> tag, 11, 27
implied lines, 253
indent settings, 49, 253
index.html file

naming, 69
saving, 32

information architecture, 68, 253
information box container, styling, 232–236
inline styles, 50, 175, 253
Insert panel, displaying, 86
Inspect mode, 45
interactive forms

adding function to, 164
form tags, 162–163
inserting text from Word, 161–162
list labels, 163
Select form, 163
styling, 165
text fields, 162–163
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navigation links, changing, 33–34
navigation sidebar

adjusting widths, 143–144
checking work, 141–142
client requirements, 141
inserting images in, 144–145
modifying margins, 143–144
positioning images in, 145–146
styling, 106–108, 142–143

navigation tags, inserting, 149–150
NC (NonCommercial), 255
ND (NoDerivs), 255
negative space, 255

O
object shadow, 255
<ol> tag, 49
open source, 255
opening

page-starter.html file, 24, 54
prototype.html, 105
responsive-starter.html file, 53
Site Setup dialog window, 39
web pages, 9
website-specs.txt, 78

optimization, 102, 255
optional content, adding with library items,  

189–194. See also content
organic lines and shapes, 255
organization of content, viewing, 26. See also 

document tree
OS X, system and folder names, 210
override settings, applying in custom CSS files, 

222–224

P
<p> tag, 10
page elements, positioning with CSS, 89–95
page font settings, displaying, 75
page inspector, starting in browser, 224
page margin settings, displaying, 75. See also 

margin settings
page properties, modifying, 71–76
page title, 73, 255
pages. See web pages
page-starter.html file, opening, 24, 54
panel groups, 41–42
panel options, accessing, 53
panels and panel groups, 52–59

linting technology, 170, 254
list items, assigning width and margins to, 150
list labels, including in interactive forms, 163
list properties, removing defaults for, 150
lists

creating, 80
unordered, 80

Live view, 31, 44, 46–47, 254
modifying Bootstrap properties, 219–220
of responsive design, 210–211

local and remote files, synchronizing, 199–200. 
See also files

Love Hate/Love makes me happy, 153
LVHA (link, visited, hover, active), 153

M
Macromedia, 15
mailto: link, 161
margin settings

adjusting, 143–144
applying to list items, 150
displaying, 75
fixing, 94–95

media queries, 46, 254
in Bootstrap, 217
in CSS Designer panel, 55
and HTML5 tags, 212–213
and responsive design, 208–214

metadata, 254
Microsoft Word, cleaning up tables from, 155–157
minified, 254
mission class, 11
mobile design, 207
model releases, 254
monochromatic, 254
monospaced fonts, 254
movement, 254

N
naming

files and folders, 18
websites, 22

<nav> tag, inserting, 148–150
navigation elements

adding links to other pages, 147–148
background colors for images, 151
hover values, 153–154
removing default list properties, 150
setting link values, 152–153
width and margins for list items, 150
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refreshing files, 57
related files, 45, 256. See also files
remote and local files, synchronizing, 199–200. 

See also files
remote server. See also server

defining, 195–196
publishing to, 197–198
updating files on, 198–199

repetition, 256
replacing images, 34–35
representative shapes, 256
Resample Image tool, 117
resizing images, 116
responsive design, 207–214
responsive-starter.html file, opening, 53–54
RGB (red, green, blue), 256
rhythm, 256
root folder, 16–17, 256
round-trip editing with Photoshop, 51, 

118–120, 256
rows in tables, styling, 158–159
rule of thirds, 257

S
SA (ShareAlike), 257
sans serif fonts, 257. See also fonts
saving files, 32
scaling images, 114–115
script fonts, 257. See also fonts
secondary colors, 257. See also colors
Select form, inserting, 163
selecting tags, 27
selector types, 176
semantic structure, 77–81
serif fonts, 257. See also fonts
server. See also remote server

versus client, 6
connecting to, 57
defined, 257

shapes, 255, 257
Sharpen tool, 117
shorthand notations, setting in CSS, 177–178
sidebar

adjusting widths, 143–144
checking work, 141–142
client requirements, 141
inserting images in, 144–145
modifying margins, 143–144
positioning images in, 145–146
styling, 106–108, 142–143

paragraph 
settings and spacing, 255
styles, 12–13

pasting text, 73–74
path

defined, 255
determination of, 17
to images, 188

pattern, 255
phone app, building, 237
photos. See images
Photoshop, round-trip editing with, 118–120
pictograph (pictogram), 255
pictures. See images
plain text, copying, 74
PNG (Portable Network Graphics), 102
preferences, setting, 112
Preview in Browser, 47, 110, 171
primary colors, 255. See also colors
profile page, customizing, 214
project creep, 208, 255
project deadlines, 255
project files, copying, 20–21. See also Chris  

the Cartoonist project; files
project scope, 256
properties, modifying, 30
Property inspector, 30, 41–42, 256

for images, 50–52
Inline styles, 50
switching views of, 48–49
views, 52

Property inspector for text
in CSS mode, 49–52
in HTML mode, 48–49

proportion (scale), 256
protocol, 5, 256
prototyping in web design, 105. See also responsive 

prototype page
pseudo-class selectors, 176, 256

listing, 153
setting hover values with, 153–154
setting link values with, 152–153

public domain, 256
publishing to remote server, 197–198
put, 256. See also copying; get

R
radial, 256
Ray the hipster werewolf, 72
reflected highlight, 256
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tagline, 136
text, 78

subfolders, 17
subtractive color, 258. See also colors
Subversion, 258
<summary> tag, 11
swashes, 258
symmetrical, 258
synchronizing files, 57, 199–200. See also files
syntax

coloring, 30, 59
defined, 7, 258

T
table and table cell properties, setting, 157
<table> tag, 11
tables

cleaning up from Word, 155–157
styling alternate rows in, 158–159

tag selector, 48
tagline, styling, 136
tags. 8–10, 14, 258. See also HTML5

<a>, 11, 27–28
<article>, 11
<blockquote>, 49
<body>, 9, 27, 76
<div>, 85–88, 92–95, 127–129
<em>, 49
<h1>, 10, 26
<head>, 9, 26
<img>, 11, 27
<li>, 80
<nav>, 148–150
<ol>, 49
<p>, 10
selecting, 27
<strong>, 49
<style>, 26
<summary>, 11
<table>, 11
<td>, 76
<th>, 76
<title>, 9, 26
<ul>, 49

team page, building, 187–188. See also web pages
templates

creating, 183–184
defined, 258

site definition, creating, 21–22. See also websites
site reports, running, 170
Site Setup dialog window, opening, 39
site structure, creating, 68
sitemap

creating, 68
defined, 257

size of window, 47
sizing images, 114–115
sketches, 257
slab serif fonts, 257
small caps, 257
Snippets panel, opening, 216
space, 257
specifications, 257
spelling, checking, 170
Split view mode, 25, 257
starter page, customizing, 32–35. See also web pages
static website, 15–16, 258
stock photos, 258
storyboard, 258
<strong> tag, 49
structured data, styling, 155–159
structured layouts, creating with images, 125–132
style (line), 258
style rules. See CSS styling rules
style sheets, 7

commenting, 179–180
converting to external CSS files, 180–182
defined, 248
float property, 121–122
shorthand notations, 177–178
source order, 178–179
types of, 175
viewing disabled, 25

<style> tag, 26
styles, applying to paragraphs, 12–13. See also 

default styles; element styles
styling

card container, 231
company name with Edge Fonts, 135–136
<div> tags, 92–95
hyperlinks in footer, 95
image container for CSS3 animation, 232
information box container, 232–236
interactive forms, 165
navigation sidebar, 106–108, 142–143
rows in tables, 158–159
structured data, 155–159
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W
W3C (World Wide Web Consortium), 10, 206, 259
W3C HTML Reference Page, 10
web. See World Wide Web
web address, example of, 5
Web browser. See browser
web fonts, 168–169, 259. See also fonts
web pages. See also home page; starter page; 

team page
adding to sites, 188
copying, 32
explained, 14
glyph library, 218–219
hidden formation, 26
HTML (Hypertext Markup Language), 26
making, 9–10

Webcomic Alliance podcast, 64
websites. See also Dreamweaver websites; site 

definition
“Capes & Babes” online comic, 64
defined, 259
structure of, 15–16
W3C HTML Reference Page, 10

website-specs.txt, opening, 73, 78
weight (line), 259
widths, adjusting. See also column widths

adjusting, 143–144
assigning to list items, 150

window size, 47
wireframes

defined, 259
working with, 83–85

Word, cleaning up tables from, 155–157
workspace

customizing, 53
layout, 23, 259

World Wide Web, 4, 13, 259
writing in code, learning, 7. See also code
WULVS (Werewolves UnLimited Valuables Security 

Services), 67
WYSIWYG (What You See Is What You Get), 15

tertiary colors, 258. See also colors
text

adding colors to, 12
cutting and pasting, 73–74
inserting into interactive forms, 161–162
styling versus formatting, 78
and text formats, 77–81

text fields, inserting into interactive forms, 162–163
text links, removing default styles from, 135
texture, 258
thumbnails of images, displaying, 51
title, changing for web page, 33
<title> tag, 9, 26
toolbars. See coding tools; Document toolbar
tracking, 258
type size, 258
typeface, 258

U
<ul> tag, 49
unity, 259
unordered list, creating, 80
updating files on server, 198–199
URL (Universal Resource Locator), 259
usability of site, 68, 259

V
value, 259
variety, 259
varying width lines, 259
vertical and vertical scale, 259
videos

for ACA objectives, 240–246
delivering web pages, 7

View menu, 25
viewport, 259
views

choosing, 43
Property inspector, 52
switching between, 31, 43
switching for Property inspector, 48
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